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บทที� 2 

แผนที�เสน้ระดบั พิกดั ผิวดิน 

 
จุดพิกัด 
จุดพิกัด คือ ค่าของตวัเลขที่ใช้อธิบายตําแหนง่ของจุดบน
ระนาบทีด่ินทีไ่ด้จากการสํารวจ ค่าทีไ่ด้จะนาํมาวางไว้ใน 
Excel หรือ Notepad ก็ได ้ตวัอย่างไฟล์ของข้อมูลเป็นดังภาพ 
ซึ่งเรียงตามลําดับคอลัมน์ ได้แก่ ชื่อจดุ, พิกดัตะวันออก (X), 
พิกัดเหนือ (Y) และคา่ระดับ (Z)  
 
 
 
เริ่มต้นการทํางาน 
เลือกทูลบาร์ “แผนที่ 2 มติ”ิ ในการทาํงานในทูลบารน์ี้จะเลือกการทํางานตามลําดับการสอน สามารถนําเข้า
ไฟล,์ แก้ไข/เพ่ิมจุดพิกดั, คาํนวณผวิสามเหลี่ยม, ตั้งค่า/สร้างเส้นระดับ, สร้างอกัษรระดับตัดเส้น, ทําเส้นระดบั
เป็นเสน้พีลายโคง้มน, สรา้งเส้นกรติ, สร้างสญัลักษณ์ และนําข้อมูลออกเปน็ไฟล์ (.CSV) ได ้
 

การนําจุดพิกดัเขา้จากไฟล ์Excel 
เป็นการนําไฟล์ข้อมูลจุดพิกดัเขา้มาใน Drawing ซึ่งไฟล์ Excel ที่จะนาํเขา้มานั้นจะต้องบันทกึเปน็นามสกลุ 
(.CSV) เท่านัน้ โดยการกําหนดจะกําหนดเปน็ความกว้างของแถวตวัอกัษรที่จะเข้ามา 
เลือกไอคอน  (นําจุดพิกดัเขา้จาก EXCEL) หรือจากแถบเมน ู“แผนที ่2 มิต ิ-> จุดพิกัด -> นําจุดพิกดัเข้า
จาก Excel” โปรแกรมจะแสดงหน้าต่าง “นําเข้าจดุจาก CSV ไฟล”์  
ในตาราง “นําเข้าจดุจาก CSV ไฟล”์ นัน้มขี้อสังเกตอยู่ตรงทีว่่า ในการเลือกใช้นัน้จะทําเปน็ลําดับ 1 2 3 และ 
4 กํากับไว ้ให้เลือกตามลําดบัที่นําเข้าทุกครัง้ ไม่ควรขา้มขั้น หรือ ลืมเลือกตรงจุดใด  
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คลิกเลือกปุ่ม  (1.กรุณาเลือกไฟล)์ เพ่ือเลือกไฟล์ Excel เข้ามา 
 

 
 

เมื่อเลือกแลว้จะแสดงหน้าตา่ง open ขึ้นมา เลือกไปยังที่อยู่ของไฟล ์
ถ้าเกดิวา่หาไฟล์ไม่เจอเชน่ในกรณดีังภาพด้านล่างนี ้
 

 
 

ให้เลือกปุม่ด้านล่างทางขวาเลือกเปน็ Files (*.csv) ไฟล์ท่ีอยู่ใน Folder นี้ก็จะแสดงแตไ่ฟล์ท่ีเป็น .csv เท่านัน้ 
 

 



 

บทท่ี 2 แผนท่ี เส้นระดับ พิกัด ผวิดิน| 8 

 

เมื่อเจอไฟล์ท่ีต้องการแลว้เลอืกที่ชื่อไฟล์ แลว้คลิกปุ่ม Open 
 

 
 

เมื่อนําเข้ามาแล้วจะแสดงการเลือกดังภาพ 
 

 
 

ในช่องทีแ่สดงตวัอย่างพิกดันั้น จากภาพแสดงตัวอย่างเพ่ือว่าตอนที่เกบ็ข้อมูลนั้นอาจไมไ่ด้เรียงตามลําดับที่
โปรแกรมเรียงไว้ให ้เช่นว่าในการบันทกึจะเรียงบนัทึกจาก POINT, N, E, ELEV ซึ่งในที่นี้สามารถเปลี่ยนได้จาก
ในช่องลําดับข้อมูลทีน่ําเข้า สามารถเปลี่ยนการวางลําดบัการนําเข้าได้  
 

 
ภาพแสดงการเปลี่ยนลําดับการนาํเขา้ 

 

ต่อมาเลือก 2.บนเลเยอร์ เป็นการตัง้ชื่อเลเยอร์ของไฟล์ท่ีเรานาํเขา้มา สามารถตัง้ชื่อเลเยอร ์หรือ เลอืกลูกศรสี
ดําเล็กๆเพ่ือเลือกชื่อเลเยอรไ์ด้เลยในทีน่ี้เลือกเปน็เลเยอร์ E 
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คลิกปุ่ม  (3.ข้อมูลถูกตอ้ง) ข้อมูลจากไฟล์ท่ีนาํเข้าทั้งหมดจะมาแสดงในชอ่งตารางที่ตอนแรก
ว่างอยู่ โดยสามารถแก้ไขขอ้มูลได้จากปุม่  และ  จากดา้นบนของตาราง 
 

 
 

คลิกปุ่ม  (ถูกแล้วนําเข้าเปน็จุดพิกัด) 
 

 
 

 
ใน Drawing ก็จะได้ข้อมูลทีเ่ป็นจดุพิกัด 
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การแก้ไขจุดพิกดั 
เป็นการแก้ไขจุดพิกดัทีน่ําเขา้มาแลว้ โดยการแก้ไขนัน้สามารถแก้ไขไดเ้พียงทีละจดุพิกัด โดยเลือกไปยังจดุพิกัด
ที่ต้องการแก้ไขคลกิให้เปน็สนี้ําเงนิ จากนัน้คลิกขวาแลว้เลือก Property  
 

 
 

จะแสดงหน้าต่างคุณสมบัตขิองจดุพิกัดที่เลือกขึน้มา สาํหรับการแกไ้ข  
 

Geometry  
 Position X เลือกแกไ้ขพิกดั X 

Position Y เลือกแก้ไขพิกัด Y 
Attributes  
 ELEV เลือกแกไ้ขค่าระดบั 

STATION เลือกแก้ไขชื่อจดุ  
 

 

การเพ่ิมจุดบนจอ 
เป็นการเพ่ิมจดุพิกัดโดยการใส่ค่าโดยตรง เลือก แผนที่ 2 
มิติ -> จุดพิกัด -> เพ่ิมจุดบนจอ แล้วคลิกทีต่ําแหน่งที่
ต้องการวางจดุ หรือถ้าต้องการใส่ค่าตําแหน่งพิกดัให้กด 
Enter ไดเ้ลย จะขึน้หน้าตา่ง Add Point ให้ใส่ค่าพิกัด 
East(X) และ North(Y) เมื่อใส่ค่าพิกัดแลว้กด ใช ่
 
 

เลือกแลว้คลิกขวา 
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จะแสดงหน้าต่าง Edit Attributes ให้ใส่ค่า ELEV (ค่า
ระดบั) และ STATION (ชื่อจุด) เมือ่ใส่ค่าเรียบร้อยแลว้กด 
OK จุดพิกัดที่เพ่ิมก็จะมาแสดงอยู่ใน Drawing  
 

 
 
 
 
 
คํานวณผิวจากจุด 
เป็นการคาํนวณผิวสามเหลีย่มจากจุดพิกดัเป็น TIN model 
เป็นการสรา้งผวิสามเหลี่ยมจําลองภูมิประเทศ โดยเลอืกที่
ไอคอน  (คํานวณผวิจากจุด) หรือจากแถบเมนู “แผนที ่
2 มิติ -> คํานวณผิวจากจดุ” จะแสดงหน้าตา่ง เลือกผิวที่
ทํางาน ให้เลือกผิวปัจจบุันเป็นผิว 0 ทั้งนี้ในช่องสามารถตั้ง
ชื่อต่างๆ ลงไปได้ เมื่อได้แลว้กด ใช ่
 

 
 
แสดงหน้าตา่งถดัมา SELECT LAYER โปรแกรมจะถามว่าจุดระดับอยู่ท่ีไหน 
เลือกเลเยอร์ท่ีตอ้งการคํานวณ ให้เลือกที่เลเยอร์ E เพราะจดุพิกัดทีเ่รานําเข้า
นั้นอยู่ท่ีเลเยอรน์ี้ เมื่อได้แลว้กด OK 
 

  
 
 
 
 

สังเกตที่เมาส์จะแสดงเปน็รปูสี่เหลี่ยมเล็กๆ ใหเ้ลือกจุด
พิกัดทั้งหมดแลว้กด Enter 
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ภาพที่ได้จากการคํานวณผวิจากจุด 

 
การสรา้งเส้นระดับ 
ในการสร้างเสน้ระดบันัน้เปน็การสร้างเส้น Contour ที่ระดบั ต้องตัง้ค่าเสน้ระดบั
เสยีก่อน โดยเลอืกไอคอน  (ตั้งค่าเสน้ระดับ) เมื่อเลือกแล้วจะแสดงตวัช่วยใน
การตั้งค่าขึ้นมาตามภาพ 
หรือถ้าตอ้งการตัง้ค่าทีม่ากกว่าที่เครื่องมือเลอืกคําสัง่ม ี สามารถพิมพ์คา่ไดท้ี่ 
Command line ได้เลย 
 
 
เพ่ิมเติม 
เมื่อเลือกคําสั่ง “ตั้งค่าเสน้ระดับ” แลว้หน้าต่าง “เลอืกคําสั่ง” ไม่แสดง 
ให้เลือก Start -> All Programs -> PowerCivil2010 -> คลิกเลือก 
Enable Helper แล้วจะมีหนา้ต่าง “เลือกเปดิตัวชว่ย PowerCivil” 
ขึ้นมาให้เลือกปุ่ม “ใหม้”ี และกดกากบาทสแีดงที่ด้านขวาบนเพ่ือปดิ 
 

เมื่อตัง้ค่าเพ่ือสร้างเส้นระดบัเรียบร้อยแลว้ ใหเ้ลือกไอคอน  (สร้างเส้นระดับทั้งหมด) เมื่อคลิกแลว้

จะเกดิเส้นระดับในระดับทีต่ัง้ค่าไว้ ดังภาพ 
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   เส้นระดบัที่ 0.5 เมตร 
 
อักษรระดับ 
จุดประสงคเ์พ่ือให้แสดงค่าเส้นระดับบนเสน้ระดบัที่สร้างไวเ้พ่ือให้ได้ง่ายต่อการดู
แบบ ทั้งนี้ในการสร้างเสน้อกัษรระดับนั้นจะตอ้งสรา้ง 3 เหลี่ยม และเสน้ระดับแล้ว 
ถ้ามแีล้วเรียบรอ้ยแลว้ให้เลอืกที่ปุ่มไอคอน  (อักษรระดบัตดัเส้น) หรือจากแถบ
เมนู “แผนที ่2 มติิ -> ค้นหาข้อมูล -> อักษรระดบัตดัเส้น” จะแสดงหนา้ตา่งตัว
ช่วยขึน้มาตามภาพด้านขวา 
เป็นการเลือกขนาดตวัอักษรที่จะแสดงใหเ้ลือกขนาดที่ 2 ตามภาพ หรือถ้าต้องการ
ให้เล็กกว่านีก้็เลือกขนาดทีร่ะบุไว้ แตถ่้าต้องการกาํหนดค่าเองก็สามารถทาํได้ โดยการพิมพ์คําสั่งตรงได้เลยที่ 
Command line แล้วกด Enter 
 

เมื่อได้ขนาดตวัอักษรไดแ้ลว้ ต่อมาให้เลือกทางที่จะแสดงค่าเมือ่ได้ให้ขดีเสน้ตดัผ่านตรงเส้นระดบัตามภาพ
ด้านลา่ง ก็จะไดต้ัวอกัษรกาํกับบนเส้นระดับที่เราขดีเสน้ตัดผ่านไป 
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เราสามารถเปลี่ยนสีตวัหนังสือได้เพ่ือให้ดไูดง้่ายขึน้ โดยการเลือกไปที่ปุ่มไอคอน  (เลเยอร)์ บน Autocad 
แล้วเลอืกเปลี่ยนสีท่ีเลเยอรช์ื่อ etxt ซึ่งเปน็เลเยอร์ของตัวหนังสืออักษรระดับตัดเสน้ที่ทําไป ตามภาพด้านบน
ได้เปลี่ยนสีเป็นสแีดง 
 
เส้นระดับเป็นเส้นโค้งมน 
ตอนทีเ่ราสร้างเสน้ระดบันัน้ เส้นระดับที่ได้จะเปน็เส้นตรง โดยที่เสน้ตรงแต่ละเสน้จะไมต่่อกนัหรือเสน้ line เรา
ต้องการเชือ่มเสน้ให้เป็น Polyline และโคง้มนดว้ยทําไดโ้ดยเลือกปุ่มไอคอน  (เชื่อมพีลาย, โคง้มน) สังเกต
ที่เมาส์จะเป็นรูปสี่เหลี่ยมเลก็ๆ ใหค้ลิกคลมุทั้งหมดของเส้นระดับแล้วกด Enter 
 

 
ภาพที่ได้จากการสร้างพีลาย, โคง้มน 

 

หรือต้องการสร้างพีลายพร้อมค่าระดบักํากับเสน้เปน็การสร้างเสน้พีลายให้โค้งมน พร้อมกบัอักษรบอกระดับใน
เส้นทุกเสน้กํากับไว ้เลือกจากแถบเมนู “แผนที่ 2 มิต ิ-> เส้นระดับและเสน้กรดิ -> พีลายมีเส้นระดบั” จากนั้น
คลิกคลุมทัง้หมดแล้วกด Enter 
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โดยที่โปรแกรมจะเปลี่ยนชนิดของเสน้ (Line Type) ตามชื่อของเลเยอร์ เช่น 
 

 
 
สร้างเส้นขอบเขต 

เป็นการนําเสน้ขอบเขตเขา้มาใน Drawing โดยการนําเข้าจะนําเข้าจาก Excel เลือกปุ่มไอคอน  (นําจดุ
พิกัดเขา้จาก Excel) 1.กรุณเลือกไฟล์ เลือกไฟล์ชื่อ bound.csv 
2.บนเลเยอร์ เลือกเลเยอร์ B 
3.เลือกกดปุ่มข้อมูลถูกตอ้ง 
4.นําเข้าเปน็เส้นพีลาย 
 

 
 

จะไดเ้ส้นขอบเขตดังรูปด้านล่าง เปลี่ยนสีเสน้ใหดู้ชัดเจนโดยสามารถเลือกได้ท่ีไอคอน  
(Color Control) ที่ autocad 
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ภาพจากการนําเข้าเสน้ขอบเขต (เสน้สีแดง) 

 
เส้นกริดบอกพิกดั 
เป็นสว่นของการสรา้ง Grid line N-E ตามระยะทีก่ําหนด เลือกปุ่มไอคอน  (เสน้กรดิ) “แผนที่ 2 มิต ิ-> 
เส้นระดบัและเส้นกรดิ -> สร้างเสน้กรดิ” เมื่อคลิกเลือกแล้วจะแสดงหน้าต่าง “เส้นกริดสีเ่หลี่ยม” ขึ้นมาใหต้ั้ง
ค่า จะมีการตัง้ค่า X, Y, ขนาดตวัอักษร, ตั้งเลเยอร ์โดยตั้งคา่ตามนี ้
 

ระยะระหว่าง X(E)  เลือกตัง้ค่าที ่50.00 
ระยะระหว่าง Y(N)  เลือกตัง้ค่าที ่50.00 
ตัวอกัษรสูง   เลือกตัง้ค่าที ่2.5 
บนเลเยอร์   เลือกตัง้ค่าที ่gridline 
เมื่อตัง้ค่าเรียบรอ้ยแลว้เลือกปุ่ม ใช ่

 
 
 

จากนัน้ให้เลือกครอบคลุมแผนที่ท่ีทําไว้ เวลาครอบให้ครอบแต่พอดีถ้าครอบใหญไ่ปเส้นกรดิจะมีขนาดให้ตาม
ไปดว้ย ทางทีด่ีให้ครอบแตพ่อดีกับแผนทีเ่พ่ือที่จะได้ออกมาสวยงาม 
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ภาพจากการสร้างเสน้กริดบอกพิกัด 

 
สัญลักษณ์แผนท่ี 
การใส่สัญลักษณ์บนแผนที่ทําเพ่ือใช้แสดงรายละเอียดของภาพ ช่วยให้ทราบสถานที่ แผนที่ท่ีดแีละถูกต้องจะ
แสดงเครื่องหมายบอกสัญลกัษณ์และเครื่องหมายกํากับไว้เสมอ ทัง้นี้เพ่ือใหแ้ผนที่นัน้เหมาะแก่การใช้งานและ
ความสวยงาม  
เลือกปุ่มไอคอน  (สัญลกัษณ์แผนที)่ หรือจากแถวเมนู “แผนที่ 2 มิต ิ-> สัญลักษณ์แผนที”่ จะแสดง
หน้าต่าง Select Symbol ดังรปู 
 

 
 

เลือกสัญลกัษณ์ท่ีจะแสดงสญัลักษณ์แรก สัญลักษณบ์อกทิศ ในการเลือกให้เลอืกทางด้านซ้ายและทางด้านขวา
จะแสดงบลอ๊กภาพที่เลือกหรือสามารถเลอืกได้จากบล๊อกด้านขวากไ็ด ้เมื่อไดแ้ลว้กด OK นําบลอ๊กมาวางไว้ใน
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ส่วนทีต่อ้งการ ในการวางคลิก 1 ครั้งเพ่ือวางตําแหน่ง สังเกตว่าภาพจะตามเมาสม์าอีกครัง้ให้ปรับขนาดภาพให้
พอดีกับทีต่้องการแล้วคลิกอกีครั้งเพ่ือวางขนาดภาพก็จะได้ขนาดภาพและตําแหน่งทีต่้องการ 

 
 

 
 

ภาพแสดงการนําเข้าสัญลกัษณ์บอกทิศ ถ้าไม่พอใจกับขนาดหรือทีต่ั้งสามารถย้ายไดแ้ละปรับขนาดไดต้ามใจ
ชอบ โดยใช้เครื่องมือ Move ของ Autocad เพ่ือย้ายตําแหน่งของสญัลักษณ์ และ Scale ของเครือ่งมอื 
Autocad เพ่ือปรับขนาดของสัญลักษณต์ามทีต่้องการ 
เลือกสัญลกัษณ์ท่ีสองที่จะแสดง สญัลักษณบ์อกมาตราส่วน เปน็สัญลักษณ์ท่ีบอกให้ผู้ท่ีอ่านแผนที่ได้ทราบวา่
ระยะทางที่เปน็จรงิบนพ้ืนโลก เลือกสัญลักษณ์ชือ่ Scale50 
 



 

บทท่ี 2 แผนท่ี เส้นระดับ พิกัด ผวิดิน| 19 

 
 

เมื่อได้สัญลกัษณ์แลว้นํามาวางใน Drawing ข้อควรระวังคือมาตราสว่นไม่สามารถปรบัขนาดไดต้ามใจชอบ 
ดังนัน้เมื่อวางแลว้ใหดู้ตรง Command line จะถามว่า Enter Scale ให้พิมพ์ค่าตรง Command line เป็น 1 
แล้วกด Enter จะได้ค่ามาตราส่วนที่เปน็จรงิ ตามภาพ 
 

 
สัญลักษณ์ท่ีสามเปน็สัญลักษณ์ข้อความ เปน็เหมือนชือ่แผนที ่เพ่ือเปน็การบ่งชี้ว่าแผนที่นี้คอือะไร 
เลือกสัญลกัษณ์ชื่อ Title20 
 

 
 

เมื่อเลือกได้แลว้นํามาวางใน Drawing การวางจะวางเหมือนกบัการวางสัญลกัษณ์บอกทิศ คือ คลิก1ครัง้เพ่ือ
วางตําแหน่ง แล้วคลิกอกี1ครั้งเพ่ือวางขนาด ทัง้นี้เราสามารถกลับมาปรบัขนาดและย้ายตําแหนง่ได้ใหม ่ส่วน
ตรงข้อความนั้นตอนวางจะเป็นข้อความ XXX ให้ดับเบิล้คลิกที่ตวัขอ้ความแล้วพิมพ์ข้อความที่ช่อง Value แล้ว
กด OK 
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จะได้สัญลักษณ ์3 อย่าง คือ สัญลัษณ์บอกทิศ สัญลักษณ์บอกมาตราส่วน และสญัลักษณ์ข้อความ สามารถใส่
เพ่ิมเติมได้จากนี ้วธิีการในการใช้ใกล้เคียงกันเพียงแต่ยกตัวอย่างใหดู้ 3 สัญลักษณ์เพ่ือเป็นแนวทาง 
 

  ภาพที่ได้จากการใส่สัญลักษณ์แผนที ่
 
นําตาราง Excel มาใส่ใน Drawing 
เป็นการนําข้อความพิกัดจาก Excel เข้ามาในงานของเราโดยที่จะมตีารางแถวเหมอืนใน Excel ตัวอย่างที่จะ
นํามาใชน้ี้เปน็ไฟล์ Excel ชื่อ bound.csv ที่เราไดน้ําเขา้เป็นเส้นขอบเขต โดยใน Drawing เราจะแสดงตาราง
เส้นขอบเขตของแผนที ่
เปิดไฟล์ bound.csv ให ้Copy ตั้งแต่ A1-C19 โดยเวน้แถวที ่20 ไวเ้พราะว่าแถวที่ 20 จะเหมือนกับแถวที่ 1 
ซึ่งเป็นจดุที่มาบรรจบกนัในแผนที ่
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Copy เรียบร้อยแล้วมาที่ Autocad เลือก Edit -> Paste Special เป็นการเลอืกวางแบบพิเศษ 
 

 
 

เมื่อเลือกแลว้จะแสดงหน้าตา่ง Paste Special ขึ้นมาและจะมีชอ่งตวัเลือกในช่องนัน้ให้เลือก AutoCAD 
Entities  
 



 

บทท่ี 2 แผนท่ี เส้นระดับ พิกัด ผวิดิน| 22 

 
 

เมือ่เลือกแลว้สังเกตที่เมาส์จะมีตารางตามมาด้วย เลือกวางยังตําแหน่งทีต่้องการ เมือ่วางแล้วตารางจะมีขนาด
เล็กให้ปรับขนาดที่เครื่องมือ Scale แล้วปรับให้พอดีกบัความต้องการ 
การแทรกเซลลข์องตาราง ทําเหมอืนกบัการแทรกเซลล์ของ Excel โดยเลือกที่ตาราง เลือกที่ชอ่งตาราง A1 
ขอ้สังเกตคอืพอเลือกตารางแล้วเครื่องมือของตารางก็จะแสดงมาดว้ยให้เลือกไอคอน  (Insert Raw 
Above) เพ่ือแทรกเซลล์ข้างบน 
 

 
 

พิมพ์หัวเรือ่งตรงทีแ่ทรกมา 
 

 
 
นําเข้าขอ้มูลจาก Gamin  
เปิดโปรแกรม MapSource ขึ้นมา เลือก File -> Open แล้วเลือกไฟลข์้อมูลทีต่้องการ 
 

 
 



 

บทท่ี 2 แผนท่ี เส้นระดับ พิกัด ผวิดิน| 23 

 
 

เลือก Tab Tracks(1) เลือกที่ชื่อคลิกขวาแล้วเลือก Show Selected Track On Map ข้อมูลภาพก็จะแสดง
ทางด้านขวามือ 
 

 
 

จากนัน้ Save ไฟล์เปน็นามสกุล .DXF 
File -> Save as เลือก Save as type เป็น DXF (*.dxf) 
 

 
 

เมื่อบนัทึกแล้วจะแสดงหน้าต่าง DXF Export Customization จากหน้าต่างนี้ให้เลอืกตั้งค่าตามนี ้
Document Extents ติ๊กเลอืก Use UTM coordinates 
Elevation range ติ๊กเลอืก Include elevation information พิมพ์ค่า 1 
*ถ้าตรง Elevation range ไม่ใช่ค่าเมตร(M) ต้องเปลี่ยนค่าใหเ้ป็นเมตร เพราะโปรแกรม Power Civil คํานวณ
ทุกอย่างเป็นเมตรหมด ต้องเปลี่ยนในชอ่ง Include elevation information ใหม่ เช่น เป็นค่า ft ให้พิมพ์ค่า 
0.305 เพราะถ้าบนัทึกมาแล้วจะได้คา่เมตรพอดี จากนัน้กด OK 
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เสร็จแลว้มาทีโ่ปรแกรม Power Civil เปิดไฟล์ท่ีบนัทึกไวถ้้าหาไม่เจอใหเ้ปลี่ยน Files of type เปน็ 
.DXF(*dxf)  เลือกไฟล์แลว้กด Open 
 

 
 

 
ภาพที่ได้จากการเปิดไฟล์ .dxf 

 

 
ถ้าต้องการกํากับจดุพิกัดบน Drawing ให้เลือกไอคอน  (พิกัดแบบลูกศร) หรอืจากแถวเมนู “เครื่องมือ -> 
พิกัดแบบลูกศร” เมือ่คลิกเลือกจะแสดงหน้าตา่งตัวชว่ยขึ้นมา เลือกที่ปุ่ม จุดปลายคลิกเลือกมุมทีต่้องการแสดง
ค่าพิกัด สังเกตว่าเสน้จะตามเมาส์มาให้คลกิ 1 ครั้งเพ่ือวางลูกศร แลว้จะมเีส้นตามเมาส์มาอกีให้วางอีก 1 ครั้ง 
เพ่ือวางตัวอักษร จะไดต้ามภาพ 
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สร้างจุดพิกดัให้กับแผนท่ี 

เลือกที่ไอคอน  (ส่งออกเป็น csv) หรือจากแถวเมนู “แผนที่ 2 มิติ -> ส่งออกเป็น csv” เมือ่เลอืกจะแสดง
หน้าต่าง ส่งออกเปน็ csv ให้เลือกอกัษรนําโดยเลือกลกูศรเล็กๆ จะมีให้เลอืก 
 

 
 

จากนัน้เลือกปุ่ม  เลือกพีลาย คลิกแล้วเลอืกแผนที่โดยแผนที่จะเป็นเสน้พีลายอยู่แลว้ เมื่อคลิกทีเ่ส้น
แล้วโปรแกรมจะแสดงจดุพิกัดวา่มีจํานวนกี่จุด คลกิ OK จํานวนจดุพิกัดทัง้หมดจะแสดงในตาราง 
 

 
 
เมื่อได้จุดพิกดัแล้วใหเ้ลือกทีปุ่่ม  (เลือกไฟล)์ โปรแกรมจะแสดงหน้าต่าง Save as ให้ตั้งชื่อไฟลแ์ล้วกด 
Save 
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ในช่องทีว่่างจะแสดงที่อยู่ท่ีจะบันทกึไฟล์นี ้โปรแกรมจะยังไมบ่ันทกึให้ ใหค้ลิกปุ่ม  (ส่งออก) เพ่ือส่งออก
ไปยังไฟล์ท่ีบันทึก 
 

 
 

เมือ่ส่งออกแลว้โปรแกรมจะบอกวา่ได้บนัทึกแล้วใหก้ด OK แล้วออกจาก
หน้าต่างนี้ได้เลย 
 
เลือกไอคอน  (นําจดุพิกัดเขา้จาก Excel) เปดิไฟล์ท่ีบนัทึกเมื่อกีน้ี้เข้ามา โดยการนําเข้าเป็นจดุพิกัด 
 

 
ภาพที่ได้จากการนําเข้าจดุพิกัด 


